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		Land Acknowledgment

								

	
				[image: A photograph of a tree with red leaves with blue sky behind and a line of green trees.]“Thames River and its side, London Ontario“, by vision chen, CC BY-NC 2.0. The Land Acknowledgement is done to remember and honour those that cared for and lived on the land 1000s of years before it became Canada. The Land Acknowledgement tells the true history of this land we call Canada, and that it was inhabited by the First Peoples long before Christopher Columbus claimed to discover it. From the first moment Columbus came to the America’s violence and colonization occurred and continues today (Robertson, 2019).
 We acknowledge and honour the Anishinaabe, Haudenoshaunee, and Lenape people of Southwestern Ontario as the traditional owners and custodians of the lands and waterways where Fanshawe College is located. Further, we acknowledge the cultural diversity of all Indigenous peoples and pay respect to Elders past, present and future. We celebrate the continuous living cultures of the original inhabitants of Canada and acknowledge the important contributions Indigenous people have and continue to make in Canadian society. The College respects and acknowledges our Indigenous students, staff, Elders and Indigenous visitors who come from many nations.
 
 While land acknowledgements are an important starting point for working towards truth and reconciliation, it’s essential that we remember that that’s what it is: a starting point. If we do land acknowledgements without taking serious steps towards understanding the truth of Canada’s shameful history of oppression of Indigenous peoples (that continues today) and without actively working towards challenging and dismantling Settler Colonialism, our land acknowledgements become meaningless tokens.
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		Equality, Diversity, & Inclusion

					The Centre for Equity, Diversity and Inclusion at Fanshawe

			

	
				 [image: Students walking in Fanshawe college hallway]Photo © Fanshawe College, All Rights Reserved Fanshawe College is committed to fostering a place where we belong. Of our six EDI priorities, one speaks to belonging in our workplaces. As field placement partners, we invite you to also create a sense of belonging in your work with us to align with our EDI priorities. This value alignment is of paramount importance to ensure a safe, equitable, and fair space for our students to feel heard and appreciated in the work that they do. Fanshawe is committed to fostering this attitude in our students as well, and the expectation of our students is they will work to foster this type of environment while on field placement.
 
 How can we all create a place where we belong?
 Here are seven tips for creating an inclusive and safe workplace:
 	Have safe and confidential spaces to report instances of inequity, discrimination, and harassment.
 	Use pronouns when you introduce yourself, and in email signatures.
 	Proactively remove barriers to Equity, Diversity, Inclusion, and Accessibility by doing an EDIA Audit and link progress to actionable, measurable, and scheduled outcomes.
 	Commit your organization to lifelong unlearning and learning through formal EDI education and allowing both employees and student placements to informally engage in community to unlearn and learn.
 	Offer anti-discrimination and anti-racism training, with particular emphasis on name discrimination and how it relates to students from equity deserving communities.
 	Start meetings with a personal land acknowledgement, and give others the opportunity to do so as well.
 	Promote a culture of work-life balance and demonstrate a commitment to the diverse ways that looks for equity deserving communities.
 
 
 Resources:
 	Advancing Justice, Equity, Diversity, and Inclusion in Work Integrated Learning [PDF]
 	What Works Toolkit
 	The Guide to Allyship
 	Gender Unicorn 
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		About This Book

								

	
				 Accessibility Statement
 We are actively committed to increasing the accessibility and usability of the textbooks we produce. Every attempt has been made to make this OER accessible to all learners and is compatible with assistive and adaptive technologies. We have attempted to provide closed captions, alternative text, or multiple formats for on-screen and off-line access.
 The web version of this resource has been designed to meet Web Content Accessibility Guidelines 2.0, level AA. In addition, it follows all guidelines in Appendix A: Checklist for Accessibility of the Accessibility Toolkit – 2nd Edition.
 In addition to the web version, additional files are available in a number of file formats including PDF, EPUB (for eReaders), and MOBI (for Kindles).
 If you are having problems accessing this resource, please contact us at oer@fanshawec.ca.
 Please include the following information:
 	The location of the problem by providing a web address or page description
 	A description of the problem
 	The computer, software, browser, and any assistive technology you are using that can help us diagnose and solve your issue (e.g., Windows 10, Google Chrome (Version 65.0.3325.181), NVDA screen reader)
 
 
 Feedback
 Please share your adoption, and any feedback you have about the book with us at oer@fanshawec.ca
 
	

			
			


		
	
		
			
	
		

		Chapter 1 - Getting Started

	

	
		 [image: Three children playing outside.]Photo by Laura Ohlman, Unsplash License. Chapter Overview
 1.0 Overview of the ECE Program
 1.1 Overview of the ECE Program Field Placements
 1.2 Welcome to the Early Childhood Education(ECE) Field Practicum Open Education Resource
  
  
  
 
 
	

		


		
	
		
			
	
		

		1.0 Overview of the ECE Program

								

	
				[image: Stack of pencil crayons.]Photo by Markus Spiske, Unsplash License. The Early Childhood Education Diploma Program at Fanshawe College combines theory and coursework with practical experience in the Early Years Profession. While students are out in the community completing Field Placements, they will learn the importance of play in children’s learning, curriculum and pedagogy design, family involvement and partnership, and child development.
 Early Childhood Education Diploma graduates will be able to apply for the College of Early Childhood Educators and be qualified for many career opportunities, such as Early Childhood Educators in Child Care Programs, Kindergarten Programs, Before and After – Extended Day Programs,  EarlyON, and Family Centres.
 Fanshawe College offers the ECE Diploma at the London Campus and all Regional Campuses. The ECE Program is also delivered in various formats – In Person, Online, and Fast Track.
 
 	Early Childhood Education Program – In Person and Online – 60 Weeks
 	Early Childhood Education Fast Track Program – In Person – 37 Weeks
 	Early Childhood Education – Fast Track Program – Online – 45 Weeks
 
 
 
 Visit page 1.0 Overview of the ECE Program, to access the links to these resources.
 	Early Childhood Education Program – In Person and Online – 60 Weeks
 	Early Childhood Education Fast Track Program – In Person – 37 Weeks
 	Early Childhood Education – Fast Track Program – Online – 45 Weeks
 
 
 
	

			
			


		
	
		
			
	
		

		1.1 Overview of the ECE Program Field Placements

								

	
				The Field Placement Model for the ECE Diploma Programs is the same whether you are in the Online, In Person or Fast Track program. There are 3 Field Placements opportunities, and each placement requires students to attend for 168 hours. Upon graduation, you will have gained entry-level skills in a variety of Early Years settings.
 There are 3 Field Placements Requirements:
 FLDP 1022 Field Practicum 0-3 Years – Childcare In a child care setting with infants, toddlers or preschoolers, students will have the opportunity to integrate their knowledge of child development into a play-based curriculum by implementing ‘How Does Learning Happen,’ using appropriate and inclusive practice through routines, interactions, and experiences which encourage play and exploration. Students will foster nurturing and supportive relationships, responding sensitively to the children’s needs, and utilizing guidance techniques that balance autonomy and security. Professional attitudes and behaviours are expected.
 Chapter 5 – FLDP 1022 Field Practicum 0-3 Years
 
  
 FLDP 3023 Field Practicum 3-6 Years – Preschool or Kindergarten In a Kindergarten or Child Care setting with children ages 3-6 years, students will have the opportunity to integrate their knowledge of child development into a play-based curriculum by implementing the Kindergarten document or How Does Learning Happen? document, using appropriate and inclusive practice through routines, interactions, and experiences which encourage play, exploration, and inquiry-based learning. Students will foster nurturing and supportive relationships, responding sensitively to the children’s needs, and utilizing guidance techniques that balance autonomy and security. Professional attitudes and behaviours are expected.
 Chapter 6 – FLDP 3023 Field Practicum 3-6 Years
 
  
 FLDP 3024 Field Practicum 0-12 Years – Child Care, Kindergarten or an Alternate Early Years Agency In an Early Years setting with children ages 0-12 years, students will have the opportunity to integrate their knowledge of child development into a play-based curriculum by implementing the Early Childhood Education documents. They will use appropriate and inclusive practice through routines, interactions, and experiences that encourage play, exploration, and inquiry-based learning. Students will foster nurturing and supportive relationships, responding sensitively to the children’s needs and utilizing guidance techniques that balance autonomy and security. Professional attitudes and behaviours are expected.
 Chapter 7 – FLDP 3024 Field Practicum 0-12 Years
 
  
 
 Course Descriptions in Early Childhood Education Courses © Fanshawe College, All Rights Reserved.
 
	

			
			


		
	
		
			
	
		

		1.2 Welcome to the Early Childhood Education (ECE) Field Practicum Open Education Resource

								

	
				Welcome to the Early Childhood Education (ECE) Field Practicum Open Education Resource. This OER will provide Students, Community Partners, and ECE Faculty a Resource Hub to guide them through the Early Childhood Education Diploma Field Placement Journey.
  
 Students [image: ]The OER is set up to guide students during the ECE diploma program by preparing them for field placement during the first semester and then providing them resources and field placement workbook forms to support them through the ECE diploma program.
  
 Community Partners [image: ]As you navigate this OER, you will find information to help you prepare to mentor ECE Students.
  
 Fanshawe College Faculty Advisors [image: ]The OER will provide information to support the student and community partner to have a cohesive partnership for mentoring ECE Students.
  
 ECE Field Coordinators [image: ]The OER will provide information to assist in setting up Field Placements for ECE Students, assist with Pre Placement Requirements, Field Placement Workbook Forms, and the PLAR Process.
  
 
	

			
			


		
	
		
			
	
		

		Chapter 2 - Field Practicum Partnership

	

	
		 [image: A toddler playing with bubbles.]Photo by Leo Rivas, Unsplash License. Chapter Overview
 2.0 Learning Objectives
 2.1 ECE Field Practicum Roles and Responsibilities
 2.2 Early Childhood Education Field Placement Students
 2.3 Early Childhood Agency Mentor
 2.4 Fanshawe College Faculty Advisor
 2.5 Field Practicum Partnership Guide
 
 
	

		


		
	
		
			
	
		

		2.0 Learning Objectives

								

	
				 Learning Objectives
  This chapter will help the Field Practicum Partners (ECE Students, Agency Mentors, and Faculty Advisors) to:
 	Define their Roles and Responsibilities and what to expect during the Field Practicum.
 	Use Field Practicum/Field Placement terminology interchangeably throughout OER.
 
 
 
 
	

			
			


		
	
		
			
	
		

		2.1 ECE Field Practicum Roles and Responsibilities

								

	
				[image: 2 adult women sitting on the floor with 3 children playing with legos]“Minister of State visits early childhood development centre,” by Province of British Columbia, CC BY-NC-ND 2.0. The Field Practicum experience is an integral part of the Early Childhood Education Diploma Program. It is the opportunity for an ECE Student to connect theory to practice in a variety of Early Year settings. It also provides the ECE Student resources and mentorship so they can learn and develop entry-level skills to become a quality Early Childhood Educator.
 The Field Practicum Field Placement is a collaborative early years experience that includes a partnership with a Field Practicum Agency Mentor, Fanshawe College Faculty Advisor, and Early Childhood Education Student. The Field Practicum Partnership has the responsibility to collaborate, support, guide, and provide an opportunity for a successful early childhood education field placement.
 
	

			
			


		
	
		
			
	
		

		2.2 Early Childhood Education Field Placement Students

								

	
				 [image: ]
 ECE Student Role: An individual who is supported and guided by a mentor in order to learn, improve their professional practice, or acquire new skills (College of Early Childhood Educators, 2018).
 
 	Complete the Field Practicum Pre-Placement Requirements – Semester 1
 	Successfully complete FLDP 1021 Field Orientation with a Passing Grade- Semester 1
 	Complete any Early Years Agency Policy and Procedures Review and/or attend Orientation
 	Follow all Early Years Agency Policies, Practices, and Procedures
 	Share Field Practicum Workbook with Agency Mentor
 	Work collaboratively with the Agency Mentor and Agency Staff members
 	Complete the Field Practicum Workbook
 	Attend Field Placement on scheduled days and complete all hours
 	Participate in all aspects of the Early Years Agency
 	Demonstrate the Learning Outcomes outlined in the Field Practicum Workbook
 	Review Progress with the Agency Mentor
 	Conduct oneself in a professional and ethical manner
 	Take initiative and responsibility in learning
 	Be curious, open, and interested in new learning and approaches
 	Accept and reflect on constructive feedback
 	Willing to be questioned and challenged in their perspectives
 
 
	

			
			


		
	
		
			
	
		

		2.3 Early Childhood Agency Mentor

								

	
				 [image: ]Agency Mentor Role: An individual who shares and uses their knowledge, skills, and experiences to support and guide a mentee to improve their practice and acquire new skills (College of Early Childhood Educators, 2018).
 
 	Guide, support, and empower ECE Students
 	Build a relationship with ECE student
 	Create a welcoming environment for the ECE Student to learn
 	Lead by example
 	Work collaboratively
 	Take responsibility for their professional practice
 	Engage and interact in ECE Student’s learning
 	Review ECE Student’s field placement requirements – workbook
 	Communicate expectations with ECE Students
 	Provide thoughtful, reflective, and constructive feedback
 	Learn from each other(Agency Mentor and ECE Student)
 	Build a learning partnership with ECE Student and College Faculty Advisor
 	Ensuring a respectful, inclusive, and collaborative partnership with ECE Student and Faculty Advisor
 
 
 	Their Pedagogical Practice [PDF] 
 
 
 
 Visit page 2.3 Early Childhood Agency Mentor, to access the link to this resource.
 	Their Pedagogical Practice [PDF] 
 
 
 
	

			
			


		
	
		
			
	
		

		2.4 Fanshawe College Faculty Advisor

								

	
				 [image: ]Fanshawe College Faculty Advisor Role: A Fanshawe College Faculty assigned to an ECE Student to deliver, facilitate, support, and evaluate the ECE student’s field placement experience.
 
 	Connect with the ECE student and communicate expectations for the Field Placement
 	Facilitate and engage the student in the field practicum course resources and workbook
 	Communicate expectations for an ECE field placement
 	Available to answer questions and guide the ECE Student Practice
 	Collaborate with the ECE Agency Mentor to support the ECE student
 	Review, evaluate, and grade all Field Practicum requirements in partnership with ECE Agency Mentor
 
 
	

			
			


		
	
		
			
	
		

		2.5 Field Practicum Partnership Guide

								

	
				  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=120#h5p-1 
 
  
 Image Description The image depicts a triangular relationship between three entities: an “ECE Student,” an “ECE Agency Mentor,” and a “Fanshawe College Faculty Advisor.” At the centre of the triangle is a large circle containing various action words that describe the nature of interactions and roles shared among the three entities. The words in the central circle are Collaborate, Guide, Mentor, Encourage, Lead, Connect, Communicate, Observe, Respect, Share, and Support.
 The “ECE Student” is at the top of the diagram, with the “ECE Agency Mentor” positioned at the bottom left and the “Fanshawe College Faculty Advisor” on the bottom right. Arrows between the central circle and the three entities suggest mutual engagement and communication focused on guiding and supporting the student’s development. This image illustrates the collaborative and supportive roles of both mentors and advisors in helping the ECE (Early Childhood Education) student thrive.
  
 [image: Diagram showing relationship between ECE student, faculty advisor, and agency mentor]“Field Practicum Relationships” by Sanaz Habibi, CC BY-NC-SA 4.0 Image Description: The image depicts a triangular relationship between three entities: an “ECE Student,” an “ECE Agency Mentor,” and a “Fanshawe College Faculty Advisor.” At the centre of the triangle is a large circle containing various action words that describe the nature of interactions and roles shared among the three entities. The words in the central circle are Collaborate, Guide, Mentor, Encourage, Lead, Connect, Communicate, Observe, Respect, Share, and Support. The “ECE Student” is at the top of the diagram, with the “ECE Agency Mentor” positioned at the bottom left and the “Fanshawe College Faculty Advisor” on the bottom right. Arrows between the central circle and the three entities suggest mutual engagement and communication focused on guiding and supporting the student’s development. This image illustrates the collaborative and supportive roles of both mentors and advisors in helping the ECE (Early Childhood Education) student thrive.
 
 
	

			
			


		
	
		
			
	
		

		Chapter 3 - Mentoring Relationships

	

	
		 [image: Toddler playing in the grass.]Photo by Moon Family, Pexels License. Chapter Overview
 3.0 Learning Objectives
 3.1 Mentoring Relationship
 3.2 Additional Resources
  
  
 
 
	

		


		
	
		
			
	
		

		3.0 Learning Objective

								

	
				 Learning Objective
  By the end of this chapter:
 	The Agency Mentors, ECE Students, and Fanshawe College Faculty Advisors will be engaged in mentoring practices as part of their practicum experience.
 
 
 
 [image: Wordle focusing on growth, togetherness, collaboration, inspiration, etc.]Wordle, by Sheryl Third, CC BY-NC-SA 4.0 
 The delicate balance of mentoring someone is not creating them in your own image but giving them the opportunity to create themselves.– Steven Spielberg.
 
 To begin, let us look at how our regulatory body, the College of Early Childhood Educators, defines Mentoring:
 “A reciprocal, relationship-based and process-oriented professional learning experience between two individuals (a mentor and a mentee) in the early learning and care sector. The purpose of the relationship is to learn and improve professional practice through reflective practice, self-directed learning, and collaboration”. A Mentor is an individual who shares and uses their knowledge, skills, and experiences to support and guide a mentee to improve their practice and acquire new skills” (College of Early Childhood Educators, 2018, p.2).

 
	

			
			


		
	
		
			
	
		

		3.1 Mentoring Relationship

								

	
				 Activity
  The videos below will spark conversation and reflection about what traits and dispositions to look for as an Early Years Mentor. The videos will also provide thoughts and ideas on what a positive mentor relationship will look like in the day-to-day work of Early Years Professionals.
 
  
 Watch this video: Mentors for Beginning Early Childhood Teachers.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=195#oembed-1 
 
 Video: “Mentors for Beginning Early Childhood Teachers” by ACECQA [5:54] is licensed under the Standard YouTube License.Transcript and closed captions available on YouTube.
 
 Watch the video Mentors for Beginning Early Childhood Teachers on YouTube at https://www.youtube.com/channel/UC4jbFzqJIONDJzFtAnKgrsA
 
 Watch this video: Wisdom of Wolves: Leadership Lessons from Nature.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=195#oembed-2 
 
 Video: “Wisdom of Wolves: Leadership Lessons from Nature” by Simple Truths [3:50] is licensed under the Standard YouTube License.Transcript and closed captions available on YouTube.
 
 Watch the video Wisdom of Wolves: Leadership Lessons from Nature on YouTube at https://www.youtube.com/watch?v=U6EKK0EZm40
 
 After watching the videos, what are the dispositions and the messages that resonate with you as you embark on mentoring ECE students in the Early Years Profession?
 Reflect and consider your dispositions for mentoring:
  What are my Strengths?
 	Demonstrate enthusiasm for learning and seek multiple perspectives.
 	Exemplify positive professional ethics and behaviours.
 	Have a positive attitude that expresses wonder and awe towards my work.
 	Devote the time needed to develop positive and effective relationships.
 	Encourage, motivate, and empower others to achieve their professional goals.
 	Find joy and passion in my day to day routines and work.
 	Play and have fun.
 	Show appreciation.
 	Reflect and ask questions.
 
 If you answered Yes to most of the above dispositions, you are ready to mentor an ECE Student.
 (Zachary, 2012).
 
 
 
	

			
			


		
	
		
			
	
		

		3.2 Additional Resources

								

	
				If you wish to explore the topic of Mentoring, you can explore these additional resources:
 
 	Mentoring: In Search of Meaning — Strive
 	The College of Early Childhood Education also has a Resource on Mentoring
 
 
 
 Visit page 3.2 Additional Resources, to access the link to this resource.
 	Mentoring: In Search of Meaning — Strive
 	The College of Early Childhood Education also has a Resource on Mentoring
 
 
 Listen to this short video about Standard 5.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=384#oembed-1 
 
 Video: “Standard IV: Learning through Mentorship” by College of Early Childhood Educators / Ordre des éducatrices et des éducateurs de la petite enfance [2:54] is licensed under the Standard YouTube License.Transcript and closed captions available on YouTube.
  
 Watch this video on Reciprocity in Mentor Mentee Relationships.
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=384#oembed-2 
 
 Video: “Simon Sinek: Why Reciprocity Improves Mentor Mentee Relationships” by Capture Your Flag [1:43] is licensed under the Standard YouTube License.Transcript and closed captions available on YouTube.
 
 Watch the videos Standard IV: Learning through Mentorship and Reciprocity in Mentor Mentee Relationships at https://www.youtube.com/watch?v=peFiQRj3G5Q&t=98s and https://www.youtube.com/watch?v=NrWg1qy2WNI
 
 
	

			
			


		
	
		
			
	
		

		Chapter 4 - Field/Clinical Pre Placement Requirements and Process

	

	
		 [image: Three children playing outside in water.]Photo by Anastasia Shuraeva, Pexels License. Chapter Overview
 4.0 Learning Objective
 4.1 Field/Clinical Pre-Placement Process
  
 
 
	

		


		
	
		
			
	
		

		4.0 Learning Objective

								

	
				 Learning Objective
  By the end of this chapter, students will:
 	Complete the required Field Practicum requirements to attend Field Placement at an Early Years Agency.
 
 
 
 
	

			
			


		
	
		
			
	
		

		4.1 Field/Clinical Pre-Placement Process

								

	
				What you need to know…
 Before you start your clinical/field placement, you have to meet all of the pre-placement requirements.
 If you do not complete the requirements, you will not be assigned a placement. If you do not attend a placement, you will not graduate.
 
 Field Placement Requirements to be approved to attend Field Placement:
 The Pre Placement Coordinator will send an email with information about this process. Once you have the email, you can start the process or see the links below.
 [image: A child's elbow with two band-aids on it.]Photo by Diana Polekhina, Unsplash License These are the requirements:
 	Immunizations
 	Standard First Aid and CPR C
 	Police Vulnerable Sector Check (PVSC)
 	Consent Forms
 
  
 
 Here’s what you need to do:
 Step 1
 Find your Program’s Clinical/Field Pre-Placement Form by clicking here: Pre-Placement Forms (ensure you select the correct placement year).
 
 Step 2
 For more information, contact your Pre-Placement Coordinator.
 
 Step 3
 Book your SYNERGY Appointment by clicking here: Synergy Verified Login.
 
 
	

			
			


		
	
		
			
	
		

		Chapter 5 - FLDP 1022 Field Practicum 0-3 Years

	

	
		 [image: Two toddlers playing together wit toy cars.]Photo by Olia Danilevich, Pexels License. Chapter Overview
 5.0 Learning Objectives
 5.1 FLDP 1022 Preparation before the First Day of Field Placement
 5.2 ECE Student Field Practicum and Workbook Expectations and Requirements
 5.3 Agency Mentor Field Practicum Expectations
 5.4 Faculty Advisor Field Practicum Expectations
 5.5 FLDP 1022 Field Practicum Workbook
 5.6 Practicum Resources
 5.7 WSIB – Field Placement Injury
 
 
	

		


		
	
		
			
	
		

		5.0 Learning Objectives

								

	
				 Learning Objectives
  By the end of this chapter, students will be able to:
 	Apply current and accessible resources to the field placement experiences and document the completion of the placement learning outcomes.
 	Use OER to support ECE students, Agency Mentors, and Faculty Advisors with the expectations and requirements for the FLDP 1022 0-3 Years Field Placement.
 
 
 
 FLDP 1022 Field Practicum 0-3 Years – Child Care
 [image: A child participating in arts and crafts.]Photo, by Sigmund, Unsplash Licence. In a child care setting with infants, toddlers or preschoolers, students will have the opportunity to integrate their knowledge of child development into a play-based curriculum by implementing How Does Learning Happen, using appropriate and inclusive practice through routines, interactions and experiences which encourage play and exploration. Students will foster nurturing and supportive relationships, responding sensitively to the children’s needs and utilizing guidance techniques that balance autonomy and security. Professional attitudes and behaviours are expected.
 
 “FLDP 1022 Course Description” in Early Childhood Education Courses © Fanshawe College, All Rights Reserved.
 
	

			
			


		
	
		
			
	
		

		5.1 FLDP 1022 Preparation before the First Day of Field Placement

								

	
				 	Students must review their Synergy clearance, making sure it is up to date before they start Field Placement.
 	Reach out to your Agency Mentor/Child Care Centre Contact prior to beginning your practicum. It is suggested you contact them by phone or email one to two weeks before your start date. This provides you with an opportunity to introduce yourself, clarify your expected arrival time on your first day, and ensure you have attended any mandatory orientation.
 	Review the OER with the Faculty Advisor in FLDP 1024 Seminar.
 	Prepare a name tag – either purchase it in the Bookstore or use a lanyard and Fanshawe College ID.
 
 [image: Photo of a LTC bus.]“London Transit Bus – 22 Trafalgar“, by abdallahh, CC BY 2.0 FANCard
 Your FANCard is your official Fanshawe identification card. Your FANCard also has your built in bus pass. Simply tap your FANCard when you board any London Transit Commission (LTC) bus.
  
  
 
 
	

			
			


		
	
		
			
	
		

		5.2 ECE Student Field Practicum and Workbook Expectations and Requirements

								

	
				Information is provided in the OER for the ECE Student, Agency Mentor, and Faculty Advisor to know the expectations and requirements for the FLDP 1022 Field Practicum.
 [image: ]ECE Student Expectations
 Complete in the first 2 Weeks of Field Placement
  	Share the Google Form link with your Mentor and Faculty Advisor from OER
 	Review the Student Progress Record with Agency Mentor
 	Review and Sign the ECE Field Practicum Agreement
 	Post an ECE Student photo/information introducing yourself as a Fanshawe College ECE Field Placement Student
 	Complete the Child Care Orientation (Introductions, Read and Sign Policy Manual, etc.)
 	Discuss and record your learning goals with the Agency Mentor
 	Confirm time for Lunch/Break (1/2 hour) is included in hours at Field Placement
 	Confirm time for Reflective Practice (1/2 hour) is included in hours at Field Placement
 	Reflective Practice Time is to be completed at the centre to work on field practicum requirements: observations/documentations, reflections, and curriculum and pedagogy planning
 	Review Practicum Requirements and Workbook Expectations
 	Arrange a date to discuss the Student Progress Record with the Agency Mentor
 	Arrange a date to discuss the Student Progress Record with the Faculty Advisor
 
 
 
 Daily/Weekly Expectations
  	Fill out the Record of Total Days on the Practicum form
 	Attend Field Placement for 168 hours ex: 8 hour day = 21 days
 	Attend on scheduled days
 	Clarify expectations in participating in children’s routines (snack, transitions, etc)
 	Engage in all aspects of the Program
 	Build relationships with children
 	Work in partnership with your Agency Mentor(s) – Curriculum Planning
 	Discuss your examples of “Observations & Reflections on the Six Principles of Practice”
 	Plan Learning through Play and Inquiry Experiences with an Agency Mentor and implement on the date planned
 	Keep paperwork organized and available for review
 	Complete/document Developing Competencies as they occur and have the Agency Mentor rate them (W, S, I, or U)
 
 
 
  
 [image: ]Mid-Term Student/Agency Mentor Progress Review date (Week 7 – 8 of Field Placement)
 Final Term Student/Agency Mentor Progress Review date (Week 14 of Field Placement)
  
 Midterm Requirements
  To ensure Midterm Success:
 	Reflect and document on the Six Principles of Practice Form – observe, reflect, and document how each principle is being incorporated into practice within your assigned placement, using the ELECT and “How Does Learning Happen?” as your guide – Half to be completed by Midterm
 	Complete the Play/Learning Interactions – Half to be completed by Midterm
 	Document and implement Four Learning through Play and Inquiry Experiences – Half to be completed by Midterm
 	Complete/document Developing Competencies – 15 of the 30 examples must be complete by Midterm – 80% must be W or S to be successful
 	Obtain all Agency Mentor ratings and signatures
 	Review Mid-Term Student Progress Record with Agency Mentor
 	Meet with Faculty Advisor about Mid-term Student Progress Record – Week 7 or 8
 	Determine/discuss personal goals with the Faculty Advisor based on the Student Progress Record
 	Obtain Faculty Advisor signatures
 
 
 
 End of Term Requirements
  To ensure final success:
 	Reflect and document on the Six Principles of Practice Form – observe, reflect, and document how each principle is being incorporated into practice within your assigned placement, using the ELECT and “How Does Learning Happen?” as your guide. – All need to be completed by the Final
 	Complete the Play/Learning Interactions – All need to be completed by the Final
 	Document and implement Four Learning through Play and Inquiry Experiences – All need to be completed by the Final
 	Complete/document Developing Competencies – all 30 examples – 80% must be W or S to be successful
 	Complete All Required Field Placement Hours – 168 hours
 	Obtain all final Agency Mentor ratings and signatures
 	Review Final Term Student Progress Record with Agency Mentor
 	Organize and complete all paperwork in preparation for meeting with the Faculty Advisor
 	Meet with Faculty Advisor about Final Progress Record – Week 14 or 15
 	Determine/discuss personal goals with the Faculty Advisor based on the Student Progress Report
 	Obtain Faculty Advisor signatures
 
 
 
 
	

			
			


		
	
		
			
	
		

		5.3 Agency Mentor Field Practicum Expectations

								

	
				[image: ]Agency Mentor Expectations – Partnership with ECE Student and Faculty Advisor
 Complete in the First 2 Weeks of Field Placement
  	Welcome and tour ECE Student around the Early Years Agency
 	Have the ECE Student post a photo/information introducing themself as a Fanshawe College ECE Field Placement Student
 	Review Student Progress Record  to ECE Student
 	Review and Sign the ECE Field Practicum Agreement
 	Ensure the ECE Student has completed the Child Care Orientation (Introductions, Read and Sign Policy Manual, etc.)
 	Discuss and record learning goals with ECE Student
 	Confirm time for ECE Student’s Lunch/Break (1/2 hour) is included in hours at Field Placement
 	Confirm time for ECE Student’s Reflective Practice (1/2 hour) is included in hours at Field Placement
 	Reflective Practice Time is to be completed at the centre to work on field practicum requirements: observations/documentations, reflections, and curriculum and pedagogy planning.
 	Review Practicum requirements and Workbook expectations with ECE Student
 	Arrange a date to discuss the Student Progress Records with ECE Student
 
 
 
 Daily/Weekly Mentoring Expectations
  	Ongoing mentorship and support
 	Build a relationship with ECE Student
 	Ongoing communication, collaboration, and support
 	Ongoing constructive feedback
 	Guide, support, and empower ECE Students
 
 
 
  
 [image: ]Mid-Term Student/Agency Mentor Progress Review date (Week 7 – 8 of Field Placement)
 Final Term Student/Agency Mentor Progress Review date (Week 14 of Field Placement)
  
 By Midterm
  	Review and sign off on the ECE Student’s Six Principles of Practice Form – Half needs to be completed by Midterm
 	Review and sign off on the ECE Student’s Play/Learning Interactions – Half needs to be completed by Midterm
 	Review, sign off,  and comment on the ECE Student’s Four Learning through Play and Inquiry Experiences – Half need to be completed by Midterm
 	Rate Core Competencies – Yes or No – successfully met 100% of the core competencies.
 	Review and rate ECE Student’s Developing Competencies – 15 of the 30 examples must be complete – 80% must be rated W or S to be successful
 	Review overall Mid-Term Student Progress Record with ECE Student
 	Meet with ECE Student and Faculty Advisor about the Mid-term Progress Report – Week 7 or 8
 	Discuss ECE Student’s personal goals with ECE Student and Faculty Advisor based on the Student Progress Report
 	Evaluate and Determine ECE Student’s success (Pass or Fail)
 
 Pages found in Workbook Forms.
 
 
 End of Term Requirements
  To ensure final success:
 	Review and sign off on the ECE Student’s Six Principles of Practice Form – All to be completed by Final
 	Review and sign off on the ECE Student’s Play/Learning Interactions – All to be completed by Final
 	Review, sign off, and comment on the ECE Student’s Four Learning through Play and Inquiry Experiences – All are to be completed by Final
 	Rate Core Competencies – Yes or No – successfully met 100% of the core competencies
 	Review and rate ECE Student’s Developing Competencies – 30 examples must be complete – 80% must be rated W or S to be successful
 	Review overall Final Student Progress Record with ECE Student
 	Meet with ECE Student and Faculty Advisor about Final Progress Record – Week 13 or 14
 	Discuss ECE Student’s personal goals with the ECE Student and Faculty Advisor based on Student Progress Record
 	Evaluate and Determine ECE Student’s Success (Pass or Fail)
 
 
 
 
	

			
			


		
	
		
			
	
		

		5.4 Faculty Advisor Field Practicum Expectations

								

	
				[image: ]Faculty Advisor Expectations – Partnership with ECE Student and Agency Mentor
 Complete in the First 2 Weeks of Field Placement
  	Connect and Introduce yourself with ECE Student through email, phone, and/or Zoom
 	Review OER and Workbook forms – First visit or Zoom Meeting
 	Discuss expectations and requirements for a successful field placement
 	Review Student Progress Record with ECE Student
 	Review and Sign the ECE Field Practicum Agreement
 	Discuss and record learning goals with the ECE Student and Agency Mentor
 	Confirm that ECE Student’s Reflective Practice (1/2 hour) is included in hours at Field Placement
 	Reflective Practice Time is to be completed at the centre to work on field practicum requirements: observations/documentations, reflections, and curriculum and pedagogy planning
 	Half hour break is also included in field placement hours (confirm)
 	Review Practicum Requirements and Workbook Expectations
 	Arrange a date to discuss the Student Progress Record Midterm and Final with the ECE Student and Agency Mentor
 
 
 
 Daily/Weekly Mentoring Expectations
  	Ongoing support with Field Placement expectations and requirements
 	Build a relationship with ECE Student
 	Ongoing communication via email and visits
 	Guide, support, and empower ECE Students
 	Visit at least 3 times throughout the Field Placement to observe, build relationship, and support the ECE Student
 	Complete the visit reports
 
 
 
  
 [image: ]Mid-Term Student/Agency Mentor Progress Review date (Week 7 – 8 of Field Placement)
 Final Term Student/Agency Mentor Progress Review date (Week 14 of Field Placement)
  
 By Midterm
  	Review and sign off on the ECE Student’s Six Principles of Practice Form – Half needs to be completed by Midterm
 	Review and sign off on the ECE Student’s Play/Learning Interactions – Half needs to be completed by Midterm
 	Review, sign off, and comment on the ECE Student’s Four Learning through Play and Inquiry Experiences – Half need to be completed by Midterm
 	Rate Core Competencies – Yes or No – successfully met 100% of the core competencies.
 	Review ECE Students Developing Competencies (rated by Agency Mentor) – 15 of the 30 examples must be complete – 80% must be rated W or S to be successful
 	Review overall Mid-Term Student Progress Record with ECE Student
 	Meet with ECE Student and Faculty Advisor about the Mid-term Progress Report – Week 7 or 8
 	Discuss ECE Student’s personal goals with the ECE Student and Faculty Advisor based on the Student’s Progress Record
 	Evaluate and Determine Student’s success (Pass or Fail) with Agency Mentor
 	Add Midterm Grades in FOL
 
 
 
 End of Term Requirements
  To ensure final success:
 	Review and sign off on the ECE Student’s Six Principles of Practice Form – All to be completed by Final
 	Review and sign off on the ECE Student’s Play/Learning Interactions – All to be completed by Final
 	Review, sign off, and comment on the ECE Student’s Four Learning through Play and Inquiry Experiences – All are to be completed by Final
 	Review Core Competencies (rated by Agency Mentor) – Yes or No – successfully met 100% of the core competencies
 	Review ECE Student’s Developing Competencies – 30 examples (rated by Agency Mentor) 80% must be rated W or S to be successful
 	Review overall Final Student Progress Record with ECE Student.
 	Meet with ECE Student and Agency Mentor about Final Progress Record- Week 13 or 14
 	Discuss the ECE Student’s personal goals with the ECE Student and Agency Mentor based on the Student’s Progress Record
 	Evaluate and Determine Student’s Success (Pass or Fail ) with Agency Mentor
 	Add Final Grades to FOL
 
 
 
 
	

			
			


		
	
		
			
	
		

		5.5 FLDP 1022 Field Practicum Workbook Forms

								

	
				 [image: ]
 Access your Workbook for FLDP 1022 Field Practicum Workbook: FLDP 1022 Field Practicum Workbook
 
 
 [image: ]
 Access your Workbook for FLDP 1022 Field Practicum Workbook by visiting page 5.5 FLDP 1022 Field Practicum Workbook in Fanshawe College Early Childhood Education Field Practicum HUB
 
 
 Workbook Guides
 Make a Copy of the Practicum Workbook Forms
 To create your version of the Practicum Workbook, click on the link found in the OER (above). If you are not already signed into Google, you will be prompted to sign in.[image: Image of google login screen]Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click Make a copy.[image: Copy Document Google prompt]
 You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and place your name. When you click away, it will be saved.
 [image: Google doc file name showing My Name highlighted to change title]
 
 Sharing Your Practicum Workbook
 Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if applicable.
 To share your workbook, follow these steps.
 Click on the Share button.
 [image: Share link highlighted]
 Under General access, change from “Restricted” to “Anyone with the link”.
 [image: General access menu highlighted with anyone with link checkmarked]
 Then click on “Viewer” and change it to “Editor”.
 [image: Access menu highlighted with editor checkmarked]
 Click the Copy link button.
 [image: Copy link button highlighted]
 Now your link is copied you can email it to others who need access to the document.
 
 Completing and Signing the Practicum Workbook Forms
 The workbook contains several different types of fillable areas. While many areas are for the student or apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor. Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin typing.
 [image: example of a fill in text box]
 You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the top of the page.
 [image: text editor options]
 There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to uncheck a box, click it again.
 [image: example of a checkbox question]
 Text areas and checkboxes can also be mixed together and can be completed as outlined.
 [image: example of a mixed fill in and checkbox question]
 In some areas, you will see a Date button.
 [image: example of a signature box]
 Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
 [image: the calendar menu]
 In some areas, you might be asked for a signature. You can draw your signature through the following steps.
 Place your cursor (click) in the signature box.
 [image: a box for a signature with a cursor]
 Click on the Insert menu, choose Drawing, and then New.
 [image: the insert menu showing drawing and new]
 From the Line menu, choose Scribble.
 [image: the line menu with the scribble highlighted]Draw your signature in the box, and then click Save and Close.
 [image: A drawing of a signature]Grab the corner of the box and drag it to resize the drawing.
 [image: A drawing of a signature stretching the box it is in]
 [image: resized signature that now fits in the box]
 
 Downloading Your Practicum Workbook Forms
 When it is time to submit your completed workbook to FOL you can download a copy. To download the workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.[image: file menu showing download and Microsoft word]
 You can then upload this document into the Submission Folder in FanshaweOnline.
 
 To access more information about using Google Docs, such as making an account, visit: Appendix A: Google Skills 
 Workbook Guides
 Make a Copy of the Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=474#oembed-1 
 
 Video: “Make a Copy of the Practicum Workbook” by Fanshawe OER Design Studio [0:58] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 To create your version of the Practicum Workbook, click on the link found in the OER (above). If you are not already signed into Google, you will be prompted to sign in.
 [image: Image of google login screen]
 Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click Make a copy.
 [image: Copy Document Google prompt]
 You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and place your name. When you click away, it will be saved.
 [image: Google doc file name showing My Name highlighted to change title]
 
  
 Share Your Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=474#oembed-2 
 
 Video: “Share Your Practicum Workbook” by Fanshawe OER Design Studio [0:52] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if applicable.
 To share your workbook, follow these steps.
 Click on the Share button.
 [image: Share link highlighted]
 Under General access, change from “Restricted” to “Anyone with the link”.
 [image: General access menu highlighted with anyone with link checkmarked]
 Then click on “Viewer” and change it to “Editor”.
 [image: Access menu highlighted with editor checkmarked]
 Click the Copy link button.
 [image: Copy link button highlighted]
 Now your link is copied you can email it to others who need access to the document.
 
  
 Completing and Signing the Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=474#oembed-3 
 
 Video: “Completing and Signing the Practicum Workbook” by Fanshawe OER Design Studio [2:19] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 The workbook contains several different types of fillable areas. While many areas are for the student or apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor. Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin typing.
 [image: example of a fill in text box]
 You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the top of the page.
 [image: text editor options]
 There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to uncheck a box, click it again.
 [image: example of a checkbox question]
 Text areas and checkboxes can also be mixed together and can be completed as outlined.
 [image: example of a mixed fill in and checkbox question]
 In some areas, you will see a Date button.
 [image: example of a signature box]
 Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
 [image: the calendar menu]
 In some areas, you might be asked for a signature. You can draw your signature through the following steps.
 Place your cursor (click) in the signature box.
 [image: a box for a signature with a cursor]
 Click on the Insert menu, choose Drawing, and then New.
 [image: the insert menu showing drawing and new]
 From the Line menu, choose Scribble.
 [image: the line menu with the scribble highlighted]
 Draw your signature in the box, and then click Save and Close.
 [image: A drawing of a signature]
 Grab the corner of the box and drag it to resize the drawing.
 [image: A drawing of a signature stretching the box it is in]
 [image: resized signature that now fits in the box]
 
  
 Downloading Your Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=474#oembed-4 
 
 Video: “Downloading Your Practicum Workbook” by Fanshawe OER Design Studio [0:28] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 When it is time to submit your completed workbook to FOL you can download a copy. To download the workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.
 [image: file menu showing download and Microsoft word]
 You can then upload this document into the Submission Folder in FanshaweOnline.
 
  
 To access more information about using Google Docs, such as making an account, visit: Appendix A: Google Skills
 
 
	

			
			


		
	
		
			
	
		

		5.6 Practicum Resources

								

	
				This is a list of resources that you will need to support you in the FLDP 1022 Field Practicum.
 
 	Excerpts from Early Learning for Every Child Today [PDF]
 	How Does Learning Happen: Ontario’s Pedagogy for Early Years
 	Building On How Does Learning Happen Child Care [PDF]
 	Indigenous Early Learning and Child Care Framework – Canada.ca
 	Child Care Centre Licensing Manual | Ontario[PDF].ca
 	Canadian Centre for Outdoor Play » Outdoor Play Canada
 	Self-Regulation in Early Childhood – Self-Reg
 	Early Learning for Every Child Today [PDF]
 
 
 
 Visit page 5.6 Practicum Resources, to access the links to these resources.
 	Excerpts from Early Learning for Every Child Today [PDF]
 	How Does Learning Happen: Ontario’s Pedagogy for Early Years
 	Building On How Does Learning Happen Child Care [PDF]
 	Indigenous Early Learning and Child Care Framework – Canada.ca
 	Child Care Centre Licensing Manual | Ontario[PDF].ca
 	Canadian Centre for Outdoor Play » Outdoor Play Canada
 	Self-Regulation in Early Childhood – Self-Reg
 	Early Learning for Every Child Today [PDF]
 
 
 
	

			
			


		
	
		
			
	
		

		5.7 WSIB - Injury at Field Placement

								

	
				 If you are at a Field Placement and you are injured, please go to the link below to fill out the necessary forms.
 Also, let your Faculty Advisor and Field Practicum Coordinator know of the incident/injury.
 Clinical/Field Pre-Placement Process: Placement Injury / Incident Reporting
 
 

	

			
			


		
	
		
			
	
		

		Chapter 6 - FLDP 3023 Field Practicum 3-6 Years

	

	
		 [image: Two toddlers playing in the snow.]Photo by Polesie Toys, Pexels License. Chapter Overview
 6.0 Learning Objective
 6.1 FLDP 3023 Preparation before the First Day of Field Placement
 6.2 ECE Student Field Practicum and Workbook Expectations and Requirements
 6.3 Agency Mentor Field Practicum Expectations – partnership with ECE Student and Faculty Advisor
 6.4 Faculty Advisor Field Practicum Expectations – partnership with ECE Student and Agency Mentor
 6.5 FLDP 3023 Field Practicum Workbook
 6.6 Practicum Resources
 6.7 WSIB – in case of an injury at Field Placement
 
 
	

		


		
	
		
			
	
		

		6.0 Learning Objective

								

	
				 Learning Objective
  By the end of this chapter, students will be able to:
 	Apply current and accessible resources to the field placement experiences and document the completion of the placement outcomes.
 
 
 
 FLDP 3023 Field Practicum 3-6 Years – Preschool or Kindergarten
 [image: A child colouring a butterfly.]Photo, by Lucas Alexander, Unsplash Licence. In a Kindergarten or Child Care (Preschool) setting with children ages 3-6 years, students will have the opportunity to integrate their knowledge of child development into a play-based curriculum by implementing the Kindergarten document or How Does Learning Happen? document, using appropriate and inclusive practice through routines, interactions, and experiences which encourage play, exploration, and inquiry-based learning. Students will foster nurturing and supportive relationships, responding sensitively to the children’s needs, and utilizing guidance techniques that balance autonomy and security. Professional attitudes and behaviours are expected.
 
 “FLDP 3023 Course Description” in Early Childhood Education Courses © Fanshawe College, All Rights Reserved.
 
	

			
			


		
	
		
			
	
		

		6.1 FLDP 3023 Preparation before the First Day of Field Placement

								

	
				 	Students must review their Synergy clearance, making sure it is up to date before they start Field Placement.
 	Reach out to your Agency Mentor/Child Care Centre/School Contact prior to beginning your practicum. It is suggested you contact them by phone or email one to two weeks prior to your start date. This provides you with an opportunity to introduce yourself, clarify your expected arrival time on your first day, and ensure you have attended any mandatory orientation.
 	Review the OER with the Faculty Advisor and in FLDP 3027 Seminar.
 	Prepare a name tag – either purchase it in the Bookstore or use a lanyard and Fanshawe College ID.
 
  
 [image: Photo of a LTC bus.]“London Transit Bus – 22 Trafalgar,” by abdallahh, CC BY 2.0 FANCard
 Your FANCard is your official Fanshawe identification card. Your FANCard also has your built in bus pass. Simply tap your FANCard when you board any London Transit Commission (LTC) bus.
  
  
 
 
	

			
			


		
	
		
			
	
		

		6.2  ECE Student Field Practicum and Workbook Expectations and Requirements

								

	
				Information is provided in the OER for the ECE Student, Agency Mentor, and Faculty Advisor to know the expectations and requirements for the FLDP 3023 Field Practicum.
 [image: ]ECE Student Expectations
 Complete in the first 2 Weeks of Field Placement
  	Share the Google Form link with the Mentor and Faculty Advisor from OER
 	Review Student Progress Record with Agency Mentor
 	Review and Sign ECE Field Practicum Agreement
 	Post an ECE Student photo/information introducing yourself as a Fanshawe College ECE Field Placement Student
 	Complete the Child Care/Elementary School Orientation (Introductions, Read and Sign Policy Manual, etc.)
 	Discuss and record your learning goals with the Agency Mentor
 	Confirm time for Lunch/Break (1/2 hour) is included in hours at Field Placement
 	Confirm time for Reflective Practice (1/2 hour) is included in hours at Field Placement
 	Reflective Practice Time is to be completed at the centre/school to work on field practicum requirements: observations/documentations, reflections, and curriculum and pedagogy planning
 	Review Practicum Requirements and Workbook Expectations
 	Arrange a date to discuss the Student Progress Record with the Agency Mentor
 	Arrange a date to discuss the Student Progress Record with the Faculty Advisor
 
 
 
 Daily/Weekly Expectations
  	Fill out the Record of Total Days on the Practicum form
 	Attend Field Placement for 168 hours ex: 7 hour day = 24 days
 	Attend on scheduled days
 	Clarify expectations in participating in children’s routines (snack, transitions, etc.)
 	Engage in all aspects of the Program
 	Build relationships with children
 	Work in partnership with your Agency Mentor(s) – Curriculum Planning
 	Discuss your examples of Observations & Reflections on the Six Principles of Practice
 	Observe and Document Observations – Play/Learning Interactions
 	Plan Learning through Play and Inquiry Experiences with an Agency Mentor and implement on the date planned
 	Keep paperwork organized and available for review
 	Complete/document Developing Competencies as they occur and have the Agency Mentor rate them (W, S, I, or U)
 
 
 
  
 [image: ]Mid-Term Student/Agency Mentor Progress Review date (Week 7 – 8 of Field Placement)
 Final Term Student/Agency Mentor Progress Review date (Week 14 of Field Placement)
  
 Midterm Requirements
  To ensure Midterm success:
 	Reflect and document on the Six Principles of Practice Form – observe, reflect and document how each principle is being incorporated into practice within your assigned placement, using the ELECT and “How Does Learning Happen?” as your guide. – half to be completed by Midterm
 	Complete the Observations – Play/Learning Interactions – half to be completed by Midterm
 	Document and implement Five Learning through Play and Inquiry Experiences – half to be completed by Midterm
 	Complete/document Developing Competencies – 17 of the 35 examples must be complete by Midterm –  90% must be W or S to be successful
 	Obtain all Agency Mentor ratings and signatures
 	Review Mid-Term Student Progress Record with Agency Mentor
 	Meet with Faculty Advisor about Mid-term Student Progress Record – Week 7 or 8
 	Determine/discuss personal goals with the Faculty Advisor based on Student Progress Record
 	Obtain Faculty Advisor signatures
 
 
 
 End of Term Requirements
  To ensure Final Success:
 	Reflect and document on the Six Principles of Practice Form – observe, reflect and document how each principle is being incorporated into practice within your assigned placement, using the ELECT and “How Does Learning Happen?” as your guide – all to be completed by the Final
 	Complete the Play/Learning Interactions – all to be completed by the Final
 	Document and implement Five Learning through Play and Inquiry Experiences  – all to be completed by the Final
 	Complete/Document Developing Competencies – all 35 examples – 90% must be W or S to be successful
 	Complete All Required Field Placement Hours – 168 hours
 	Obtain all final Agency Mentor ratings and signatures
 	Review Final Term Student Progress Record with Agency Mentor
 	Organize and complete all paperwork in preparation for meeting with the Faculty Advisor
 	Meet with Faculty Advisor about Final Progress Record – Week 14 or 15
 	Determine/discuss personal goals with the Faculty Advisor based on the Student Progress Report
 	Obtain Faculty Advisor signatures
 
 
 
 
	

			
			


		
	
		
			
	
		

		6.3  Agency Mentor Field Practicum Expectations

								

	
				[image: ]Agency Mentor Expectations – Partnership with ECE Student and Faculty Advisor
 Complete in the first 2 Weeks of Field Placement
  	Welcome and tour ECE Student around the Early Years Agency
 	Review OER and the Google Form link/Workbook forms – sent to you by the College and ECE Student
 	Have the ECE Student post a photo/information introducing themself as a Fanshawe College ECE Field Placement Student
 	Review Student Progress Record with ECE Student
 	Review and Sign the ECE Field Practicum Agreement
 	Ensure the ECE Student has completed the Child Care/Elementary School Orientation (Introductions, Read and Sign Policy Manual, etc.)
 	Discuss and record learning goals with ECE Student
 	Confirm time for ECE Student’s Lunch/Break (1/2 hour) is included in hours at Field Placement
 	Confirm time for ECE Student’s Reflective Practice (1/2 hour) is included in hours at Field Placement
 	Reflective Practice Time is to be completed at the centre/school to work on field practicum requirements: observations/documentations, reflections, and curriculum and pedagogy planning
 	Review Practicum requirements and Workbook expectations with ECE Student
 	Arrange a date to discuss the Student Progress Records with ECE Student
 
 
 
 Daily/Weekly Mentoring Expectations
  	Ongoing mentorship and support
 	Build a relationship with ECE Student
 	Ongoing communication, collaboration, and support
 	Ongoing constructive feedback
 	Guide, support, and empower ECE Students
 
 
 
  
 [image: ]Mid-Term Student/Agency Mentor Progress Review date (Week 7 – 8 of Field Placement)
 Final Term Student/Agency Mentor Progress Review date (Week 14 of Field Placement)
  
 By Midterm
  	Review and sign off on the ECE Student’s Six Principles of Practice Form – Half needs to be completed by Midterm
 	Review and sign off on the ECE Student’s Play/Learning Interactions – Half needs to be completed by Midterm
 	Review, sign off, and comment on the ECE Student’s Five Learning through Play and Inquiry Experiences – Half need to be completed by Midterm
 	Rate Core Competencies – Yes or No – successfully met 100% of the core competencies
 	Review and rate ECE Student’s Developing Competencies – 17 of the 35 examples must be complete  – 90% must be rated W or S to be successful
 	Review overall Mid-Term Student Progress Record with ECE Student
 	Meet with ECE Student and Faculty Advisor about the Mid-term Progress Report – Week 7 or 8
 	Discuss ECE Student’s personal goals with ECE Student and Faculty Advisor based on Student Progress Report
 	Evaluate and Determine ECE Student’s success (Pass or Fail)
 
 Pages found in Workbook forms.
 
 
  
 End of Term Requirements
  To ensure final success:
 	Review and sign off on the ECE Student’s Six Principles of Practice Form – all to be completed by Final
 	Review and sign off on the ECE Student’s Play/Learning Interactions – all to be completed by Final
 	Review, sign off, and comment on the ECE Student’s five Learning through Play and Inquiry Experiences – all to be completed by the Final
 	Rate Core Competencies – Yes or No – successfully met 100% of the core competencies
 	Review and rate ECE Student’s Developing Competencies – 35 examples must be complete – 90% must be rated W or S to be successful
 	Review overall Final Student Progress Record with ECE Student
 	Meet with ECE Student and Faculty Advisor about Final Progress Record- Week 13 or 14
 	Discuss ECE Student’s personal goals with ECE Student and Faculty Advisor based on Student Progress Record
 	Evaluate and Determine ECE Student’s success (Pass or Fail)
 
 
 
 
	

			
			


		
	
		
			
	
		

		6.4 Faculty Advisor Field Practicum Expectations

								

	
				[image: ]Faculty Advisor Expectations – Partnership with ECE Student and Agency Mentor
 Complete in the first 2 Weeks of Field Placement
  	Connect and Introduce yourself with ECE Student through email, phone, and/or Zoom
 	Review OER and the Google Form link Workbook forms – First visit or Zoom Meeting
 	Discuss expectations and requirements for a successful field placement
 	Review Student Progress Record with ECE Student
 	Review and Sign the ECE Field Practicum Agreement
 	Discuss and record learning goals with the ECE Student and Agency Mentor
 	Confirm that ECE Student’s Reflective Practice (1/2 hour) is scheduled: included in hours at Field Placement
 	Reflective Practice Time is to be completed at the centre/school to work on field practicum requirements: observations/documentations, reflections, and curriculum and pedagogy planning
 	Half hour break is also included in field placement hours (confirm)
 	Review Practicum Requirements and Workbook Expectations
 	Arrange a date to discuss the Student Progress Record Midterm and Final with the ECE Student and Agency Mentor
 
 
 
 Daily/Weekly Mentoring Expectations
  	Ongoing support with Field Placement expectations and requirements
 	Build a relationship with ECE Student and Agency Mentor
 	Ongoing communication via email and visits
 	Guide, support, and empower ECE Students
 	Visit at least 3 times throughout the Field Placement to observe, build relationships, and support the ECE Student
 	Complete the visit reports
 
 
 
  
 [image: ]Mid-Term Student/Agency Mentor Progress Review date (Week 7 – 8 of Field Placement)
 Final Term Student/Agency Mentor Progress Review date (Week 14 of Field Placement)
  
 By Midterm
  	Review and sign off on the ECE Student’s College of ECE Code of Ethics  – Half needs to be completed by Midterm
 	Review and sign off on the ECE Student’s Play/Learning Interactions – Half needs to be completed by Midterm
 	Review and sign off on the ECE Student’s Five Learning through Play and Inquiry Experiences – Half need to be completed by Midterm
 	Review Core Competencies (rated by Agency Mentor) – Yes or No – successfully met 100% of the core competencies
 	Review ECE Student’s Developing Competencies (rated by Agency Mentor) – 17 of the 30 examples must be complete –  100% must be rated W or S to be successful
 	Review overall Mid-Term Student Progress Record with ECE Student
 	Meet with ECE Student and Faculty Advisor about Midterm Progress Report – Week 7 or 8
 	Discuss the ECE Student’s personal goals with the ECE Student and Faculty Advisor based on the Student’s Progress Record
 	Evaluate and Determine Student’s success (Pass or Fail) with Agency Mentor
 	Add Midterm Grades in FOL
 
 Pages found in Workbook forms.
 
 
 END OF TERM Requirements – to ensure Final Success
  	Review and sign off on the ECE Student’s Six Principles of Practice Form – all to be completed by Final
 	Review and sign off on the ECE Student’s Play/Learning Interactions – all to be completed by Final
 	Review and sign off on the ECE Student’s Five Learning through Play and Inquiry Experiences – all to be completed by the Final
 	Review Core Competencies (rated by Agency Mentor) – Yes or No – successfully met 100% of the core competencies
 	Review ECE Student’s Developing Competencies – 35 examples (rated by Agency Mentor) 90% must be rated W or S to be successful
 	Review overall Final Student Progress Record with ECE Student
 	Meet with ECE Student and Agency Mentor about Final Progress Record- Week 13 or 14
 	Discuss the ECE Student’s personal goals with the ECE Student and Agency Mentor based on the Student’s Progress Record
 	Evaluate and Determine Student’s success (Pass or Fail) with Agency Mentor
 	Add Final Grades to FOL
 
 
 
 
	

			
			


		
	
		
			
	
		

		6.5  FLDP 3023 Field Practicum Workbook Forms

								

	
				 [image: ]
 Access your Workbook for FLDP 3023 Field Practicum Workbook: FLDP 3023 Workbook
 
 
 [image: ]
 Access your Workbook for FLDP 3023 Field Practicum Workbook by visiting page 6.5 FLDP 3023 Field Practicum Workbook in Fanshawe College Early Childhood Education Field Practicum HUB.
 
 
 Workbook Guides
 Make a Copy of the Practicum Workbook Forms
 To create your version of the Practicum Workbook, click on the link found in the OER (above). If you are not already signed into Google, you will be prompted to sign in.[image: Image of google login screen]Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click Make a copy.[image: Copy Document Google prompt]
 You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and place your name. When you click away, it will be saved.
 [image: Google doc file name showing My Name highlighted to change title]
 
 Sharing Your Practicum Workbook
 Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if applicable.
 To share your workbook, follow these steps.
 Click on the Share button.
 [image: Share link highlighted]
 Under General access, change from “Restricted” to “Anyone with the link”.
 [image: General access menu highlighted with anyone with link checkmarked]
 Then click on “Viewer” and change it to “Editor”.
 [image: Access menu highlighted with editor checkmarked]
 Click the Copy link button.
 [image: Copy link button highlighted]
 Now your link is copied you can email it to others who need access to the document.
 
 Completing and Signing the Practicum Workbook Forms
 The workbook contains several different types of fillable areas. While many areas are for the student or apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor. Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin typing.
 [image: example of a fill in text box]
 You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the top of the page.
 [image: text editor options]
 There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to uncheck a box, click it again.
 [image: example of a checkbox question]
 Text areas and checkboxes can also be mixed together and can be completed as outlined.
 [image: example of a mixed fill in and checkbox question]
 In some areas, you will see a Date button.
 [image: example of a signature box]
 Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
 [image: the calendar menu]
 In some areas, you might be asked for a signature. You can draw your signature through the following steps.
 Place your cursor (click) in the signature box.
 [image: a box for a signature with a cursor]
 Click on the Insert menu, choose Drawing, and then New.
 [image: the insert menu showing drawing and new]
 From the Line menu, choose Scribble.
 [image: the line menu with the scribble highlighted]Draw your signature in the box, and then click Save and Close.
 [image: A drawing of a signature]Grab the corner of the box and drag it to resize the drawing.
 [image: A drawing of a signature stretching the box it is in]
 [image: resized signature that now fits in the box]
 
 Downloading Your Practicum Workbook Forms
 When it is time to submit your completed workbook to FOL you can download a copy. To download the workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.[image: file menu showing download and Microsoft word]
 You can then upload this document into the Submission Folder in FanshaweOnline.
 
 To access more information about using Google Docs, such as making an account, visit: Appendix A: Google Skills 
 Workbook Guides
 Make a Copy of the Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=569#oembed-1 
 
 Video: “Make a Copy of the Practicum Workbook” by Fanshawe OER Design Studio [0:58] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 To create your version of the Practicum Workbook, click on the link found in the OER (above). If you are not already signed into Google, you will be prompted to sign in.
 [image: Image of google login screen]
 Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click Make a copy.
 [image: Copy Document Google prompt]
 You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and place your name. When you click away, it will be saved.
 [image: Google doc file name showing My Name highlighted to change title]
 
  
 Share Your Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=569#oembed-2 
 
 Video: “Share Your Practicum Workbook” by Fanshawe OER Design Studio [0:52] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if applicable.
 To share your workbook, follow these steps.
 Click on the Share button.
 [image: Share link highlighted]
 Under General access, change from “Restricted” to “Anyone with the link”.
 [image: General access menu highlighted with anyone with link checkmarked]
 Then click on “Viewer” and change it to “Editor”.
 [image: Access menu highlighted with editor checkmarked]
 Click the Copy link button.
 [image: Copy link button highlighted]
 Now your link is copied you can email it to others who need access to the document.
 
  
 Completing and Signing the Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=569#oembed-3 
 
 Video: “Completing and Signing the Practicum Workbook” by Fanshawe OER Design Studio [2:19] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 The workbook contains several different types of fillable areas. While many areas are for the student or apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor. Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin typing.
 [image: example of a fill in text box]
 You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the top of the page.
 [image: text editor options]
 There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to uncheck a box, click it again.
 [image: example of a checkbox question]
 Text areas and checkboxes can also be mixed together and can be completed as outlined.
 [image: example of a mixed fill in and checkbox question]
 In some areas, you will see a Date button.
 [image: example of a signature box]
 Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
 [image: the calendar menu]
 In some areas, you might be asked for a signature. You can draw your signature through the following steps.
 Place your cursor (click) in the signature box.
 [image: a box for a signature with a cursor]
 Click on the Insert menu, choose Drawing, and then New.
 [image: the insert menu showing drawing and new]
 From the Line menu, choose Scribble.
 [image: the line menu with the scribble highlighted]
 Draw your signature in the box, and then click Save and Close.
 [image: A drawing of a signature]
 Grab the corner of the box and drag it to resize the drawing.
 [image: A drawing of a signature stretching the box it is in]
 [image: resized signature that now fits in the box]
 
  
 Downloading Your Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=569#oembed-4 
 
 Video: “Downloading Your Practicum Workbook” by Fanshawe OER Design Studio [0:28] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 When it is time to submit your completed workbook to FOL you can download a copy. To download the workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.
 [image: file menu showing download and Microsoft word]
 You can then upload this document into the Submission Folder in FanshaweOnline.
 
  
 To access more information about using Google Docs, such as making an account, visit: Appendix A: Google Skills
 
 
	

			
			


		
	
		
			
	
		

		6.6 Practicum Resources

								

	
				This is a list of resources that will support you in the FLDP 3023 Field Practicum. This is not an exhaustive list of resources, but some that may support your placement experience.
 
 	The Kindergarten Program [PDF]
 	The 2019 Addendum to The Kindergarten Program: Revised Specific Expectations 6.4 and 24.1 [PDF]
 	How Does Learning Happen: Ontario’s pedagogy for early years
 	Building On How Does Learning Happen Child Care [PDF]
 	Indigenous Early Learning and Child Care Framework 
 	Child Care Centre Licensing Manual [PDF]
 	Canadian Centre for Outdoor Play » Outdoor Play Canada
 	Self-Regulation in Early Childhood – Self-Reg
 	Early Learning for Every Child Today [PDF]
 	Excerpts from Early Learning for Every Child Today [PDF]
 
 
 
 Visit page 6.6 Practicum Resources, to access the links to these resources.
 	The Kindergarten Program [PDF]
 	The 2019 Addendum to The Kindergarten Program: Revised Specific Expectations 6.4 and 24.1 [PDF]
 	How Does Learning Happen: Ontario’s pedagogy for early years
 	Building On How Does Learning Happen Child Care [PDF]
 	Indigenous Early Learning and Child Care Framework 
 	Child Care Centre Licensing Manual [PDF]
 	Canadian Centre for Outdoor Play » Outdoor Play Canada
 	Self-Regulation in Early Childhood – Self-Reg
 	Early Learning for Every Child Today [PDF]
 	Excerpts from Early Learning for Every Child Today [PDF]
 
 
 
	

			
			


		
	
		
			
	
		

		6.7 WSIB - Injury at Field Placement

								

	
				 If you are at a Field Placement and you are injured, please go to the link below to fill out the necessary forms.
 Also, let your Faculty Advisor and Field Practicum Coordinator know of the incident/injury.
 Clinical/Field Pre-Placement Process: Placement Injury / Incident Reporting
 
 

	

			
			


		
	
		
			
	
		

		Chapter 7 - FLDP 3024 Field Practicum 0-12 Years

	

	
		 [image: Three children running.]Photo by Zaid Isaac, Pexels License. Chapter Overview
 7.0 Learning Objectives
 7.1 FLDP 3024 Preparation before the First Day of Field Placement
 7.2 ECE Student Field Practicum and Workbook Expectations and Requirements
 7.3 Agency Mentor Field Practicum Expectations
 7.4 Faculty Advisor Field Practicum Expectations
 7.5 FLDP 3024 Field Practicum Workbook
 7.6 Practicum Resources
 7.7 WSIB – In case of an injury at Field Placement
 
 
	

		


		
	
		
			
	
		

		7.0 Learning Objectives

								

	
				 Learning Objectives
  By the end of this chapter, students will be able to:
 	Apply current and accessible resources to the field placement experiences and document the completion of the placement outcomes.
 	Use OER to support ECE students, Agency Mentors, and Faculty Advisors with the expectations and requirements for the FLDP 3024 0-12 Years Field Placement.
 
 
 
 FLDP 3024 Field Practicum 0-12 Years – Child Care, Kindergarten or an Alternate Early Years Agency
 [image: Two children colouring at a table.]Photo, by Alan Rodriguez, Unsplash Licence. In an Early Years setting with children ages 0-12 years, students will have the opportunity to integrate their knowledge of child development into a play-based curriculum by implementing the Early Childhood Education documents. They will use appropriate and inclusive practice through routines, interactions, and experiences that encourage play, exploration, and inquiry-based learning. Students will foster nurturing and supportive relationships, responding sensitively to the children’s needs and utilizing guidance techniques that balance autonomy and security. Professional attitudes and behaviours are expected.
 
 “FLDP 3024 Course Description” in Early Childhood Education Courses © Fanshawe College, All Rights Reserved.
 
	

			
			


		
	
		
			
	
		

		7.1 FLDP 3024 Preparation before the First Day of Field Placement

								

	
				 	Students must review their Synergy clearance, making sure it is up to date before they start Field Placement.
 	Reach out to your Agency Mentor/Child Care Centre/School Contact/Early Year Agency prior to beginning your practicum. It is suggested you contact them by phone or email one to two weeks prior to your start date. This provides you an opportunity to introduce yourself, clarify your expected arrival time on your first day, and ensure you have attended any mandatory orientation.
 	Review the OER with the Faculty Advisor.
 	Prepare a name tag – either purchase it in the Bookstore or use a lanyard and Fanshawe College ID.
 
 [image: Photo of a LTC bus.]“London Transit Bus – 22 Trafalgar“, by abdallahh, CC BY 2.0 FANCard
 Your FANCard is your official Fanshawe identification card. Your FANCard also has your built in bus pass. Simply tap your FANCard when you board any London Transit Commission (LTC) bus.
  
  
 
  
  
 
	

			
			


		
	
		
			
	
		

		7.2  ECE Student Field Practicum and Workbook Expectations and Requirements

								

	
				Information is provided in the OER for the ECE Student, Agency Mentor, and Faculty Advisor to know the expectations and requirements for the FLDP 3024 Field Practicum.
 [image: ]ECE Student Expectations
 Complete in the first 2 Weeks of Field Placement
  	Share the Google Form link with the Mentor and Faculty Advisor from OER
 	Review Student Progress Record to Agency Mentor
 	Review and sign the ECE Field Practicum Agreement
 	Post an ECE Student photo/information introducing yourself as a Fanshawe College ECE Field Placement Student
 	Complete the Child Care/Elementary School/Early Year Agency Orientation (Introductions, Read and Sign Policy Manual, etc.)
 	Discuss and record your learning goals with the Agency Mentor
 	Confirm time for Lunch/Break (1/2 hour) is included in hours at Field Placement
 	Confirm time for Reflective Practice (1/2 hour) is included in hours at Field Placement
 	Reflective Practice Time is to be completed at the centre/school to work on field practicum requirements: observations/documentations, reflections, and curriculum and pedagogy planning
 	Review Practicum Requirements and Workbook Expectations
 	Arrange a date to discuss the Student’s Progress Record with the Agency Mentor
 	Arrange a date to discuss the Student Progress Record with the Faculty Advisor
 
  
 
 
 Daily/Weekly Expectations
  	Fill out the Record of Total Days on the Practicum form
 	Attend Field Placement for 168 hours ex: 7 hour day = 24 days
 	Attend on scheduled days
 	Clarify expectations in participating in children’s routines (snack, transitions, etc)
 	Engage in all aspects of the Program
 	Build relationships with children
 	Work in partnership with your Agency Mentor(s) – Curriculum Planning
 	Discuss your examples and reflections on the College of ECE Code of Ethics
 	Observe and Document Observations – Play/Learning Interactions
 	Plan Learning through Play and Inquiry Experiences with the Agency Mentor and implement on the date planned
 	Keep paperwork organized and available for review
 	Complete/document VCLO – 10 Vocational Course Learning Outcomes as they occur and have the Agency Mentor rate them (W, S, I, or U)
 
 
 
  
 [image: ]Mid-Term Student/Agency Mentor Progress Review date (Week 7 – 8 of Field Placement)
 Final Term Student/Agency Mentor Progress Review date (Week 14 of Field Placement)
  
 Midterm Requirements
  To ensure Midterm Success:
 	Reflect and document on the College of ECE Code of Ethics – observe, reflect and document how each of the Code of Ethics is incorporated into practice within your assigned placement using the College of ECE Code of Ethics and Standards of Practice as your Guide – half to be completed by Midterm
 	Complete the Observations – Play/Learning Interactions – half to be completed by Midterm
 	Document and implement Six Learning through Play and Inquiry Experiences – half to be completed by Midterm
 	Complete/Document VCLO – Vocational Course Learning Outcomes 10 in total – half to be completed by Midterm – 100% must be W or S to be successful
 	Obtain all Agency Mentor ratings and signatures
 	Review Mid-Term Student Progress Record with Agency Mentor
 	Meet with Faculty Advisor about Mid-term Student Progress Record – Week 7 or 8
 	Determine/discuss personal goals with the Faculty Advisor based on the Student Progress Record
 	Obtain Faculty Advisor signatures
 
  
 
 
 End of Term Requirements
  To ensure Final Success:
 	Reflect and document on the College of ECE Code of Ethics – observe, reflect and document how each of the Code of Ethics is incorporated into practice within your assigned placement using the College of ECE Code of Ethics and Standards of Practice as your Guide – All need to be completed by Final
 	Complete the Observations – Play/Learning Interactions – All need to be completed by Final
 	Document and implement Six Learning through Play and Inquiry Experiences – All need to be completed by Final
 	Document and implement Family Interactions/Communication with Families Experience
 	Complete/Document VCLO – Vocational Course Learning Outcomes 10 in total  – all need to be completed by Final – 100% must be W or S to be successful
 	Complete all required Field Placement Hours – 168 hours
 	Obtain all final Agency Mentor ratings and signatures
 	Review Final Term Student Progress Record with Agency Mentor
 	Organize and complete all paperwork in preparation for meeting with the Faculty Advisor
 	Meet with Faculty Advisor about Final Progress Record – Week 14 or 15
 	Determine/discuss personal goals with the Faculty Advisor based on the Student Progress Report
 	Obtain Faculty Advisor signatures
 
 
 
 
	

			
			


		
	
		
			
	
		

		7.3 Agency Mentor Field Practicum Expectations

								

	
				[image: ]Agency Mentor Expectations – Partnership with ECE Student and Faculty Advisor
 Complete in the First 2 Weeks of Field Placement
  	Welcome and tour ECE Student around the Early Years Agency
 	Review OER and the Google Form link/Workbook forms – sent to you by the College and ECE Student
 	Have the ECE Student post a photo/information introducing themself as a Fanshawe College ECE Field Placement Student
 	Review Student Progress Record  to ECE Student
 	Review and Sign the ECE Field Practicum Agreement
 	Ensure the ECE Student has completed the Child Care/Elementary School Orientation (Introductions, Read and Sign Policy Manual, etc.)
 	Discuss and record learning goals with ECE Student
 	Confirm time for ECE Student’s Lunch/Break (1/2 hour) is included in hours at Field Placement
 	Confirm time for ECE Student’s Reflective Practice (1/2 hour) is included in hours at Field Placement
 	Reflective Practice Time is to be completed at the centre/school to work on field practicum requirements: observations/documentations, reflections, and curriculum and pedagogy planning
 	Review Practicum requirements and Workbook expectations with ECE Student
 	Arrange a date to discuss the Student Progress Records with ECE Student
 
 
 
 Daily/Weekly Mentoring Expectations
  	Ongoing mentorship and support
 	Build a relationship with ECE Student
 	Ongoing communication, collaboration, and support
 	Ongoing constructive feedback
 	Guide, support, and empower ECE Students
 
 
 
  
 [image: ]Mid-Term Student/Agency Mentor Progress Review date (Week 7 – 8 of Field Placement)
 Final Term Student/Agency Mentor Progress Review date (Week 14 of Field Placement)
  
 By Midterm
  	Review and sign off on the ECE Student’s College of ECE Code of Ethics – Half needs to be completed by Midterm
 	Review and sign off on the ECE Student’s Observations – Play/Learning Interactions  – Half to be completed by Midterm
 	Review, sign off and comment on the ECE Student’s Six Learning through Play and Inquiry Experiences – Half need to be completed by Midterm
 	Rate Core Competencies – Yes or No – successfully met 100% of the core competencies
 	Review and rate ECE Student’s VCLO – Vocational Course Learning Outcomes 10 in total – Half need to be completed by Midterm, 100% must be rated W or S to be successful
 	Review overall Mid-Term Student Progress Record with ECE Student
 	Meet with ECE Student and Faculty Advisor about the Mid-term Progress Report – Week 7 or 8
 	Discuss ECE Student’s personal goals with ECE Student and Faculty Advisor based on the Student Progress Report
 	Evaluate and Determine ECE Student’s Success (Pass or Fail)
 
 Pages found in Workbook Forms.
 
 
 End of Term Requirements
  To ensure final success:
 	Review and sign off on the ECE Student’s College of ECE Code of Ethics – All to be completed by Final
 	Review and sign off on the ECE Student’s Observations – Play/Learning Interactions – All to be completed by Final
 	Review, sign off, and comment on the ECE Student’s Six Learning through Play and Inquiry Experiences – All are to be completed by Final
 	Review, sign off, and comment on the ECE Student’s Family Interactions/Communication with Families Experience
 	Rate Core Competencies – Yes or No – successfully met 100% of the core competencies
 	Review and rate ECE Student’s VCLO – Vocational Course Learning Outcomes 10 in total – All need to be completed by Final – 100% must be rated W or S to be successful
 	Review overall Final Student Progress Record with ECE Student
 	Meet with ECE Student and Faculty Advisor about Final Progress Record- Week 13 or 14
 	Discuss ECE Student’s personal goals with the ECE Student and Faculty Advisor based on the Student Progress Record
 	Evaluate and Determine ECE Student’s Success (Pass or Fail)
 
 
 
 
	

			
			


		
	
		
			
	
		

		7.4 Faculty Advisor Field Practicum Expectations

								

	
				[image: ]Faculty Advisor Expectations – Partnership with ECE Student and Agency Mentor
 Complete in the First 2 Weeks of Field Placement
  	Connect and Introduce yourself with ECE Student through email, phone, and/or Zoom
 	Review OER and Workbook forms – First visit or Zoom Meeting
 	Discuss expectations and requirements for a successful field placement
 	Review Student Progress Record with ECE Student
 	Review and Sign the ECE Field Practicum Agreement
 	Discuss and record learning goals with the ECE Student and Agency Mentor
 	Confirm that ECE Student’s Reflective Practice (1/2 hour) is scheduled: included in hours at Field Placement
 	Reflective Practice Time is to be completed at the centre to work on field practicum requirements: observations/documentations, reflections, and curriculum and pedagogy planning
 	Half hour break is also included in field placement hours (confirm)
 	Review Practicum Requirements and Workbook Expectations
 	Arrange a date to discuss the Student Progress Record Midterm and Final with the ECE Student and Agency Mentor
 
 
 
 Daily/Weekly Mentoring Expectations
  	Ongoing support with Field Placement expectations and requirements
 	Build a relationship with ECE Student
 	Ongoing communication via email and visits
 	Guide, support, and empower ECE Students
 	Visit at least 3 times throughout the Field Placement to observe, build relationships, and support the ECE Student
 	Complete the visit reports
 
 
 
  
 [image: ]Mid-Term Student/Agency Mentor Progress Review date (Week 7 – 8 of Field Placement)
 Final Term Student/Agency Mentor Progress Review date (Week 14 of Field Placement)
  
 By Midterm
  	Review and sign off on the ECE Student’s College of ECE Code of Ethics – Half needs to be completed by Midterm
 	Review and sign off on the ECE Student’s Observations – Play/Learning Interactions – Half need to be completed by Midterm
 	Review and sign off on the ECE Student’s Six Learning through Play and Inquiry Experiences – Half need to be completed by Midterm
 	Review Core Competencies (rated by Agency Mentor) – Yes or No – successfully met 100% of the core competencies
 	Review ECE Student’s VCLO – Vocational Course Learning Outcomes 10 in total (rated by Agency Mentor) – 100% must be rated W or S to be successful
 	Review overall Mid-Term Student Progress Record with ECE Student
 	Meet with ECE Student and Faculty Advisor about the Mid-term Progress Report – Week 7 or 8
 	Discuss ECE Student’s personal goals with the ECE Student and Faculty Advisor based on the Student Progress Record
 	Evaluate and Determine Student’s success (Pass or Fail) with Agency Mentor
 	Add Midterm Grades in FOL
 
 
 
 End of Term Requirments
  To ensure final success:
 	Review and sign off on the ECE Student’s College of ECE Code of Ethics – All to be completed by Final
 	Review and sign off on the ECE Student’s  Observations – Play/Learning Interactions – All to be completed by Final
 	Review and sign off on the ECE Student’s Six Learning through Play and Inquiry Experiences – All to be completed by Final
 	Review and sign off on the ECE Student’s Family Interactions/Communication with Families Experience
 	Review Core Competencies (rated by Agency Mentor) – Yes or No – successfully met 100% of the core competencies
 	Review ECE Student’s VCLO – Vocational Course Learning Outcomes 10 in total (rated by Agency Mentor) 100% must be rated W or S to be successful
 	Review overall Final Student Progress Record with ECE Student
 	Meet with ECE Student and Agency Mentor about Final Progress Record- Week 13 or 14
 	Discuss the ECE Student’s personal goals with the ECE Student and Agency Mentor based on the Student’s Progress Record
 	Evaluate and Determine Student’s success (Pass or Fail) with Agency Mentor
 	Add Final Grades to FOL
 
 
 
 
	

			
			


		
	
		
			
	
		

		7.5 FLDP 3024 Field Practicum Workbook Forms

								

	
				 [image: ]
 Access your Workbook for FLDP 3024 Field Practicum Workbook: FLDP 3024 Field Practicum Workbook
 
 
 [image: ] Access your Workbook for FLDP 3024 Field Practicum Workbook by visiting page 7.5 FLDP 3024 Field Practicum Workbook in Fanshawe College Early Childhood Education Field Practicum HUB.
 
 
 Workbook Guides
 Make a Copy of the Practicum Workbook Forms
 To create your version of the Practicum Workbook, click on the link found in the OER (above). If you are not already signed into Google, you will be prompted to sign in.[image: Image of google login screen]Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click Make a copy.[image: Copy Document Google prompt]
 You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and place your name. When you click away, it will be saved.
 [image: Google doc file name showing My Name highlighted to change title]
 
 Sharing Your Practicum Workbook
 Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if applicable.
 To share your workbook, follow these steps.
 Click on the Share button.
 [image: Share link highlighted]
 Under General access, change from “Restricted” to “Anyone with the link”.
 [image: General access menu highlighted with anyone with link checkmarked]
 Then click on “Viewer” and change it to “Editor”.
 [image: Access menu highlighted with editor checkmarked]
 Click the Copy link button.
 [image: Copy link button highlighted]
 Now your link is copied you can email it to others who need access to the document.
 
 Completing and Signing the Practicum Workbook Forms
 The workbook contains several different types of fillable areas. While many areas are for the student or apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor. Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin typing.
 [image: example of a fill in text box]
 You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the top of the page.
 [image: text editor options]
 There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to uncheck a box, click it again.
 [image: example of a checkbox question]
 Text areas and checkboxes can also be mixed together and can be completed as outlined.
 [image: example of a mixed fill in and checkbox question]
 In some areas, you will see a Date button.
 [image: example of a signature box]
 Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
 [image: the calendar menu]
 In some areas, you might be asked for a signature. You can draw your signature through the following steps.
 Place your cursor (click) in the signature box.
 [image: a box for a signature with a cursor]
 Click on the Insert menu, choose Drawing, and then New.
 [image: the insert menu showing drawing and new]
 From the Line menu, choose Scribble.
 [image: the line menu with the scribble highlighted]Draw your signature in the box, and then click Save and Close.
 [image: A drawing of a signature]Grab the corner of the box and drag it to resize the drawing.
 [image: A drawing of a signature stretching the box it is in]
 [image: resized signature that now fits in the box]
 
 Downloading Your Practicum Workbook Forms
 When it is time to submit your completed workbook to FOL you can download a copy. To download the workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.[image: file menu showing download and Microsoft word]
 You can then upload this document into the Submission Folder in FanshaweOnline.
 
 To access more information about using Google Docs, such as making an account, visit: Appendix A: Google Skills 
 Workbook Guides
 Make a Copy of the Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=532#oembed-1 
 
 Video: “Make a Copy of the Practicum Workbook” by Fanshawe OER Design Studio [0:58] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 To create your version of the Practicum Workbook, click on the link found in the OER (above). If you are not already signed into Google, you will be prompted to sign in.
 [image: Image of google login screen]
 Once you are signed in, or if you were already signed in, you will see a page asking you to make a copy. Click Make a copy.
 [image: Copy Document Google prompt]
 You will see that the title says “Copy.” Double-click on it so that it becomes editable. Delete “Copy of” and place your name. When you click away, it will be saved.
 [image: Google doc file name showing My Name highlighted to change title]
 
  
 Share Your Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=532#oembed-2 
 
 Video: “Share Your Practicum Workbook” by Fanshawe OER Design Studio [0:52] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 Your practicum workbook will also require input from your Agency Mentor and Faculty Advisor, if applicable.
 To share your workbook, follow these steps.
 Click on the Share button.
 [image: Share link highlighted]
 Under General access, change from “Restricted” to “Anyone with the link”.
 [image: General access menu highlighted with anyone with link checkmarked]
 Then click on “Viewer” and change it to “Editor”.
 [image: Access menu highlighted with editor checkmarked]
 Click the Copy link button.
 [image: Copy link button highlighted]
 Now your link is copied you can email it to others who need access to the document.
 
  
 Completing and Signing the Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=532#oembed-3 
 
 Video: “Completing and Signing the Practicum Workbook” by Fanshawe OER Design Studio [2:19] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 The workbook contains several different types of fillable areas. While many areas are for the student or apprentice to complete, there are also sections for the Agency Mentor and, if applicable, a Faculty Advisor. Areas to be filled in with text are coloured blue. To complete one of these sections, click on the box and begin typing.
 [image: example of a fill in text box]
 You can use any of the text formatting elements, such as bold, italics, bullets, etc., which can be found at the top of the page.
 [image: text editor options]
 There are also checkbox options. For a checkbox, simply click on the box you wish to choose. If you want to uncheck a box, click it again.
 [image: example of a checkbox question]
 Text areas and checkboxes can also be mixed together and can be completed as outlined.
 [image: example of a mixed fill in and checkbox question]
 In some areas, you will see a Date button.
 [image: example of a signature box]
 Hover over the button to bring up the calendar. Click on the date you want to choose, and then click Ok.
 [image: the calendar menu]
 In some areas, you might be asked for a signature. You can draw your signature through the following steps.
 Place your cursor (click) in the signature box.
 [image: a box for a signature with a cursor]
 Click on the Insert menu, choose Drawing, and then New.
 [image: the insert menu showing drawing and new]
 From the Line menu, choose Scribble.
 [image: the line menu with the scribble highlighted]
 Draw your signature in the box, and then click Save and Close.
 [image: A drawing of a signature]
 Grab the corner of the box and drag it to resize the drawing.
 [image: A drawing of a signature stretching the box it is in]
 [image: resized signature that now fits in the box]
 
  
 Downloading Your Practicum Workbook Forms Video Instructions
  One or more interactive elements has been excluded from this version of the text. You can view them online here: https://ecampusontario.pressbooks.pub/ecefieldpractium/?p=532#oembed-4 
 
 Video: “Downloading Your Practicum Workbook” by Fanshawe OER Design Studio [0:28] is licensed under the Standard YouTube License. Transcripts and closed captions are available on YouTube.
 
 
 Text Instructions
 When it is time to submit your completed workbook to FOL you can download a copy. To download the workbook into Microsoft Word, navigate to the File menu, choose Download, and Microsoft Word.
 [image: file menu showing download and Microsoft word]
 You can then upload this document into the Submission Folder in FanshaweOnline.
 
  
 To access more information about using Google Docs, such as making an account, visit: Appendix A: Google Skills
 
 
	

			
			


		
	
		
			
	
		

		7.6 Practicum Resources

								

	
				This is not an exhaustive list of resources, but some that may support your placement experience.
 
 	The Kindergarten Program [PDF]
 	The 2019 Addendum to The Kindergarten Program: Revised Specific Expectations 6.4 and 24.1 [PDF]
 	How Does Learning Happen: Ontario’s Pedagogy for Early Years
 	Building On How Does Learning Happen Child Care [PDF]
 	Indigenous Early Learning and Child Care Framework
 	Child Care Centre Licensing Manual [PDF]
 	CECE Code of Ethics and Standards of Practice for RECEs in Ontario [PDF]
 	Canadian Centre for Outdoor Play » Outdoor Play Canada
 	Self-Regulation in Early Childhood
 	Early Learning for Every Child Today [PDF]
 	Excerpts from Early Learning for Every Child Today [PDF]
 
 
 
 Visit page 7.6 Practicum Resources, to access the links to these resources.
 	The Kindergarten Program [PDF]
 	The 2019 Addendum to The Kindergarten Program: Revised Specific Expectations 6.4 and 24.1 [PDF]
 	How Does Learning Happen: Ontario’s Pedagogy for Early Years
 	Building On How Does Learning Happen Child Care [PDF]
 	Indigenous Early Learning and Child Care Framework
 	Child Care Centre Licensing Manual [PDF]
 	CECE Code of Ethics and Standards of Practice for RECEs in Ontario
 	Canadian Centre for Outdoor Play » Outdoor Play Canada
 	Self-Regulation in Early Childhood
 	Early Learning for Every Child Today [PDF]
 	Excerpts from Early Learning for Every Child Today [PDF]
 
 
 
	

			
			


		
	
		
			
	
		

		7.7 WSIB - Injury at Field Placement

								

	
				 If you are at a Field Placement and you are injured, please go to the link below to fill out the necessary forms.
 Also, let your Faculty Advisor and Field Practicum Coordinator know of the incident/injury.
 Clinical/Field Pre-Placement Process: Placement Injury / Incident Reporting
 
 
	

			
			


		
	
		
			
	
		

		Chapter 8 - Field Practicum PLAR - Prior Learning Assessment and Recognition

	

	
		 [image: Photo of children playing outside.]Photo, by RDNE Stock Project, Pexels License Chapter Overview
 8.0 Learning Objectives
 8.1 Early Childhood Education PLAR (Prior Learning Assessment and Recognition)
 8.2 Early Childhood Education Field Practicum PLAR Approval and Guides
  
  
 
 
	

		


		
	
		
			
	
		

		8.0 Learning Objective

								

	
				 Learning Objective
  By the end of the chapter, students will be able to:
 	Determine if they are eligible for PLAR and, if so, how to complete the process.
 
 
 
  
 
	

			
			


		
	
		
			
	
		

		8.1 Early Childhood Education PLAR (Prior Learning Assessment and Recognition)

								

	
				 Fanshawe College Early Childhood Education Program recognizes that practical experience and learning can happen at the college level before you begin the ECE Program. The practical experience can happen in a variety of Early Year settings outside of the formal ECE Field Practicum experience.
 
 What is PLAR?
 [image: ECE worker reading a book to a child.]Photo © Fanshawe College, All Rights Reserved Prior Learning Assessment and Recognition (PLAR) is a process of evaluating the knowledge and skills gained through experiential and/or non-formal learning for the purpose of obtaining credit. Fanshawe College recognizes that learning occurs from a wide variety of work and other life experiences outside of formal educational settings.
 Prior Learning Assessment uses a variety of tools to help learners reflect on, identify, articulate, and demonstrate past learning which has been acquired through on-the-job training, military service, community-based volunteer activities, and self-directed study that all together are not recognized through formal transfer-of-credit mechanisms. These experiences may have resulted in college-level learning and may be eligible to be credited as such.
 The College’s PLAR process is designed to accurately, fairly, and equitably assess these experiences to determine if such learning minimally meets college-level learning standards. Assessors balance the need to protect College credentials and community interests against the need to fairly recognize prior learning as college-level.
 Please note that if your course load drops below that of a full-time student because of credits earned through PLAR, eligibility for financial assistance through the Ontario Student Assistance Plan (OSAP) may be impacted.
 If you are an international student, please note that if your course load drops below that of a full-time student because of credits earned through PLAR, your current study permit and working eligibility, or your future post-graduate work permit eligibility, may be impacted.
 
 PLAR does not provide credit for prior formal post-secondary education. If you have prior learning through a recognized post-secondary institution, check for possible transfer credit first with the Advising Centre. Please refer to Policy A124, Recognition of Prior Learning [PDF].
 
 Prior Learning Assessment and Recognition (PLAR) © Fanshawe College, All Rights Reserved.
 
	

			
			


		
	
		
			
	
		

		8.2 Early Childhood Education Field Practicum PLAR Approval and Guides

								

	
				ECE Students looking to PLAR an ECE Field Practicum must:
 	Have at least 2 years paid work experience in an Early Years Setting – Child Care, Kindergarten in an Elementary School, EarlyON/Family Centre.
 	Review the Learner Guide and complete the Learner Self-Assessment in Appendix A before deciding to apply for PLAR.
 	Receive prior approval to apply to PLAR by the ECE Field Practicum Coordinator.
 	There is a PLAR application fee per course. This fee applies to both the challenge evaluation and the portfolio assessment. To see the current PLAR fee, visit Prior Learning Assessment and Recognition (PLAR).
 	Applications are filed with the Office of the Registrar.
 	If you fail to prove that you have met the learning outcomes, you are not eligible for a refund. If you have paid for a challenge evaluation and then decide to take the course instead, you are not eligible for a refund.
 	Once approved, students contact advising@fanshawec.ca to sign up, pay for PLAR, and receive a PLAR guide for the ECE Field Practicum course.
 
 
 Grade Requirements
 	Policy A124, “Recognition of Prior Learning”[PDF] guides the PLAR process at Fanshawe.
 	Transcripts of credits earned through PLAR will normally reflect a grade achieved in the same manner as credits are normally transcribed. In some cases, a successful PLAR credit will receive a grade of “P” (pass). Unsuccessful attempts will not be reflected on the transcript.
 	The grade you achieve in the PLAR assessment is the grade that will appear on your transcript once you are enrolled in a course or program at Fanshawe College.
 	The minimum grade required for a successful PLAR attempt will be the same as the minimum passing grade of that specific course.
 	To be eligible to graduate from a Fanshawe program, learners must meet residency requirements in accordance with Fanshawe Policy A122 [PDF] and achieve a cumulative 2.0/60% GPA over all courses (unless otherwise stated).
 
 Completing the PLAR Guide
  	The PLAR Advisor will give instructions to complete the PLAR Guide and may connect with the Field Coordinator for further instructions with the PLAR.
 	Once the student has completed the PLAR Guide requirements, they will send the work to advising@fanshawec.ca and the ECE Field Practicum Coordinator.
 	The Field Coordinator will review the PLAR submission, and a PLAR Advisor will process the grade.
 
 
 
 
 Prior Learning Assessment and Recognition (PLAR) © Fanshawe College, All Rights Reserved.
 
	

			
			


		
	
		
			
	
		

		Chapter 9 - The College of Early Childhood Education (CECE) - Our Professional Regulatory Body

	

	
		 [image: Two children playing outside.]Photo by Stephen Andrews, Pexels License. Chapter Overview
 9.0 Learning Objectives
 9.1 What is the College of ECE
 9.2 Becoming a College of ECE Member
  
  
 
 
	

		


		
	
		
			
	
		

		9.0 Learning Objective

								

	
				 Learning Objective
  By the end of this chapter, students will be able to:
 	Explain the requirements and process to join Ontario’s professional regulatory body once they have completed their ECE diploma.
 
 
 
 [image: A photo that says "You got this."]Photo, by Prateek Katyal, Unsplash License. 
	

			
			


		
	
		
			
	
		

		9.1 What is the College of ECE

								

	
				[image: ECE students studying together outside.]Photo, by Alexis Brown, Unsplash Licence. The College of Early Childhood Educators (CECE) regulates and governs Ontario’s Registered Early Childhood Educators (RECEs) in the public interest.
 The College was established under the Early Childhood Educators Act, 2007 (ECE Act) and came into existence in February 2009 (College of Early Childhood Educators, n.d.).
 As of 2024, there are more than  57,000 members in good standing; the College is one of Ontario’s largest professional self-regulatory bodies and is the only professional self-regulatory body for early childhood education in Canada (College of Early Childhood Educators, n.d.).
 The College regulates the profession of early childhood education by establishing and enforcing:
 	Registration requirements;
 	Ethical and professional standards for RECEs;
 	Requirements for continuous professional learning; and
 	Complaints and discipline process for professional misconduct, incompetence, and incapacity.
 
 (College of Early Childhood Educators, n.d.)
 
	

			
			


		
	
		
			
	
		

		9.2 Becoming a College of ECE Member

								

	
				[image: ]Once you have completed the ECE Diploma Program and have your ECE Diploma (final transcript), you now must register with The College of Early Childhood Education (CECE) in order to work as an early years professional and call yourself an Early Childhood Educator (RECE) in the Province of Ontario.
  
 First Step
 Once you have completed the ECE Diploma and are ready to Graduate, you are required to submit an Intent to Graduate form (scroll down to the bottom of the page).
 
 Second Step
 The CECE has a new member section on their website that includes a webinar to walk you through the registration process.
 New Member Resources | Welcome to the College of Early Childhood Educators
 
 Third Step
 Once your paperwork is processed with the Registrar’s office, usually within 10 business days, you will request an electronic transcript from MYCREDS to go directly to the CECE. Before requesting your transcript, check on Webadvisor to see if your transcript shows “graduated.”
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		Glossary

								

	
				 Administrative Leadership
 A role in which individuals create a positive organizational climate, ensure legal and financial competence, engage the community, advocate, foster innovation, and use data to inform strategic planning (Talan et al., 2023).
 
 AECEO
 Association of Early Childhood Educators Ontario.
 
 Agency Mentor
 An RECE or leader in an agency that is supporting and guiding the student.
 
 AKB
 All Kids Belong.
 
 CCEYA
 Childcare and Early Years Act.
 
 CECE
 College of Early Childhood Educators.
 
 Child-centred Curriculum
 Is planned and implemented with children’s interests, needs, capacities, and strengths at the heart of the planning process (Community Child Care, 2011).
 
 COP
 Communities of Practice is a group of educators who come together regularly to share and reflect on different topics.
 
 Curriculum
 A learning plan that summarizes what educators want children to learn, how they want them to learn it, and how they plan to teach and assess it (Brightwheel, 2024).
 
 Early Years Agency
 Business or Centre in the Early Years System.
 
 ECEA
 Early Childhood Educators Act.
 
 Emergent Curriculum
 A child-centred approach to education that evolves based on the interests, ideas, and experiences of the children, allowing their natural curiosity to guide the learning process (Bright Horizons, 2020).
 
 Faculty Advisor
 An experienced educator or academic assigned to guide and support students through their practicum, offering advice on academic matters, supporting them in their professional and personal development, providing them with accurate information, and ensuring that they meet program requirements (Academic Advising and Support Center, n.d.).
 
 Field Placement
 Refers to the specific assigned location/organization that a student practices within.
 
 Field Practicum
 A supervised, hands-on learning experience where students have the opportunity to work directly with colleagues, children, and families within an early years agency and apply their theoretical knowledge to real-world situations.
 
 LCCN
 Licensed Child Care Network.
 
 Pedagogy
 Defined as the understanding of how learning happens- the philosophy, method, and practice of facilitating learning.
 
 Pedagogical Leadership
 A role in which individuals guide and support educators to enhance teaching and learning practices through a foundation in research, child development, family engagement, and trauma-informed principles (Talan et al., 2023).
 
 Pedagogical Practices
 The methods, approaches, and strategies used to facilitate learning (ProctorEdu, n.d.).
 
 Play-Based Learning
 Learning through play. There are two types of play: Free Play, which is child-directed and motivated, and Guided Play, which involves the educator offering extended learning opportunities to the play.
 
 Professional Development
 This refers to learning opportunities such as workshops or research sessions that support and enhance professional practices.
 
 Quality
 A high level of standard that educators and early years agencies should strive for. Example: A nurturing environment that supports the social, emotional, and cognitive aspects of child development.
 
 RECE
 An Early Childhood Educator who is registered in the field.
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		Appendix A: Google Skills

								

	
				This book will contain documents to complete as part of your Practicum Workbook. These documents will require you to complete work in Google Docs. Below, you will find instructions to help you navigate through the skills needed when using the Google platform.
  
 Creating a Google Account In order to access the Practicum Workbook documents, you will need a Google account.
 If you don’t already have a Google account, you can follow these directions to create one: Creating a Google Account.
 You can find more information about Google, the privacy policy, and how to unlock your account here:
 
  
 Using Google Docs When you click on a Workbook link, you will be asked to make a copy of the document. If you are not signed in, you will be prompted to do so before you can make a copy.
 The copy of this document will be saved in your Google Drive.
 You can learn to manage your files in your Google Drive here:
 Managing Your Files (instructions)
 Managing Your Files (video)
 Renaming your document with your name and the Workbook page title is a good idea to keep things organized. You can see how to rename a document by reading the section To Create a New File on the page Creating New Files. Note: The file will not say “Untitled Document” but “Copy of Workbook page.”
 
  
 Sharing a Google Doc In order for your faculty advisor and agency mentor to collaborate on the Workbook with you, you will need to share your document with them.
 You can see instructions on how to share your document here:
 Sharing and Collaboration (instructions)
 Sharing and Collaboration (video)
 
  
 Downloading a Google Doc You will be required to upload your document into FOL. To do so, you will need to download a Microsoft Word copy of your Workbook document so you can upload it into the submissions folder.
 To see instructions on how to download your document as a Microsoft Word file, see:
 Downloading and Printing from Google Drive
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		Version History

								

	
				This page provides a record of edits and changes made to this book since its initial publication. Whenever edits or updates are made in the text, we provide a record and description of those changes here. If the change is minor, the version number increases by 0.1. If the edits involve a number of changes, the version number increases to the next full number.
 The files posted alongside this book always reflect the most recent version.
 	Version 	Date 	Change 	Affected Web Page 
 	1.0 	December 13, 2024 	First Publication 	N/A 
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